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Introduction 
Technical Memorandums and Processed Reports are the only type of Fundamental Research 
Communications published here at NWFSC. As such, in addition to the usual review process, 
they are subject to an additional editorial review by the NWFSC Technical Editor. All references 
throughout this Style Guide to “Technical Memorandums” or “Tech Memos” are understood to 
apply to both Tech Memos and Processed Reports. 

The purpose of this Style Guide is to establish and describe the basic set of formatting, stylistic, 
and grammatical guidelines for these reports, ensuring a consistent look and style both within 
and across all NWFSC Tech Memos. While following these guidelines to the letter is not 
necessary, the NWFSC Technical Editor uses this Style Guide as the basis for editing your 
manuscript. The closer your manuscript follows these guidelines, the faster the editing process, 
and the sooner we can publish your report. 

We assume that your manuscript will be prepared in Microsoft Word. The current standard is 
Word 2016 for both PC and Mac. References throughout this Style Guide to menu options or 
commands are to these versions of Word, and appear in a unique font. If you use a different 
version of Word, some of these may be slightly different. 

The Style Guide is broken into four main sections: Format, Style Conventions, Grammar and 
Punctuation, and Legal Requirements. Format covers the prewriting mechanics that apply to 
every Tech Memo, regardless of content—page and table layout, choice of font, approved color 
palettes, figure design, etc. The Style Conventions section deals with questions about abbreviating, 
using scientific names, writing numbers and equations, citing and referencing sources, and so 
forth. Grammar and Punctuation tackles a few troublesome issues related to the linguistic 
conventions of scientific English writing. The final section, Legal Requirements, explains some of 
the rules and regulations Tech Memos must comply with by virtue of their status as official 
government publications. This is where you will find guidance about accessibility and writing 
alternative text for your figures, as well.  
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Suggested Resources 
This Style Guide is meant as a quick reference to answer some of the most common questions 
about acceptable formatting, style, and grammar for reports published as NMFS-NWFSC 
scientific publications. It also covers some rules and regulations specific to federal publications. 

It is not comprehensive, and does not attempt to cover every possible issue. For questions not 
specifically addressed here, authors and editors are advised to refer to the references listed below, 
available in the Northwest and Alaska Fisheries Science Centers Library and/or online, or to 
contact the Editor directly. 

• United States Government Printing Office Style Manual, 30th edition. Online PDF.1 The 
main authority on style for all federal publications, and the primary source on which this 
Style Guide is based. 

• Merriam-Webster’s Collegiate Dictionary, 11th edition. The primary authority on spelling 
and word meanings for Tech Memos. 

• The Chicago Manual of Style, 16th edition. University of Chicago Press. This is a useful 
general authority on grammar, punctuation, format, citation and reference style, table 
structuring, and more—useful when writing Tech Memos, Processed Reports, journal 
articles, etc. 

• Instructions for Authors. Website.2 NMFS Scientific Publications Office. Provides links to 
NMFS guidelines and policies on style in publications. 

• A Guide to AFS Publications Style. Online PDF.3 American Fisheries Society. Chapter 8 
provides detailed examples of how to format references in Tech Memos. 

• Common and Scientific Names of Fishes from the United States, Canada, and Mexico, 7th 
edition. American Fisheries Society. The primary authority on fish names. For other 
species (e.g., marine mammals, birds, invertebrates, etc.), we recommend consulting the 
Integrated Taxonomic Information System.4 

• Scientific Style and Format: The CSE Manual for Authors, Editors, and Publishers, 8th 
edition. Council of Science Editors. This book is a useful authority on signs and symbols, 
mathematical expressions, and scientific conventions. 

• Social Security Administration Guide: Alternate text for images, Version 1.2. Online PDF.5 
Social Security Administration Accessibility Resource Center. Excellent guidelines for 
and examples of how to write alt-text for images.  

  

                                                
1 http://www.gpo.gov/fdsys/pkg/GPO-STYLEMANUAL-2008/pdf/GPO-STYLEMANUAL-2008.pdf 
2 http://spo.nwr.noaa.gov/authors 
3 http://fisheries.org/docs/pub_stylefl.pdf 
4 http://www.itis.gov 
5 https://www.ssa.gov/accessibility/files/SSA_Alternative_Text_Guide.pdf 
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Submitting a Manuscript 
This process is discussed in detail in the Procedure document. Here, we summarize the main 
steps related to submitting Technical Memorandums to NWFSC Publications. 

Remember that your manuscript should be submitted in several parts. Please do not combine 
everything into a single Word document. Instead, submit each of the following separately: 

1. The manuscript itself. Simply type up each section using Word’s default formatting and 
fonts. Separate different sections with blank lines. 

2. All tables and table headings. Type these into a Word document. Do not apply Word’s 
table styles; leave tables unformatted. 

3. A link to a Google Drive folder containing original copies of all images intended for use 
in the Tech Memo. Do not embed the pictures in the Word file. The Editor will insert the 
pictures during layout. 

4. Any additional files for appendices, etc. 

5. Your signed NOAA Form 25-700. This should be delivered to the Editor’s mailbox on the 
3rd floor, West building. 
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Note for Multiple Authors 
Technical Memorandums are often collaborative projects between many authors that may take 
from a few months to over a year to compile and draft. It is only natural that some 
inconsistencies would creep in. We do our best to correct for such errors during the editing 
process, but this can be time-consuming and is one of the main causes of delays. If authors are 
aware and proactive while writing, many of these issues can be avoided. 

Consistency is key. Once a pattern has been established, the same pattern should be maintained 
throughout the entire document, whether it be 50 or 500 pages. To the extent possible, all authors 
should strive to maintain consistency in: 

• Tone. Tech Memos are formal documents that are expected to maintain an elevated, 
academic tone. No one section should be noticeably more informal, verbose, fond of 
metaphors, etc., than any other. 

• Terminology. If you call them killer whales in the introduction, then continue to do so 
throughout; do not suddenly switch to orcas for a section or two. Similarly, if you often 
refer to the U.S.–Mexico border, then the other border should not be the Canada–
Washington border; instead, follow the established pattern: the U.S.–Canada border. 

• Spelling. Especially when working with international authors who may be more familiar 
with the conventions of British English, watch for consistency in spelling (American 
spelling is preferred: color, not colour; gray, not grey; program, not programme; etc.). This 
does not apply to titles of sources listed in the References section, however. 

• Measurement. Once you begin providing measurements in, e.g., m/s or km2, it is best not 
to switch to km/h or km ´ km.  

• Figure design. Be consistent in your use of font, color, size, and layout. If Figures 1–4 use 
Arial and one of the NWFSC Color Palettes, then so should Figures 5 and 6. 

• Table structure. To the extent possible, tables should follow similar organizational 
patterns. If, for example, Tables 1 and 2 have a list of references at the bottom, then Table 
3 should not have this list in a column on the right. 

• Order of key terms and concepts. Generally speaking, the first mention of a list of key 
terms establishes the order of that list as canonical for a given Tech Memo. If you say that 
you will be discussing species A, B, C, and D, then they should be referred to in that order 
whenever they appear together throughout the document—in text, figures, tables, 
appendices, and everywhere else—and never as, e.g., species D, B, A, and C. 

• References. As discussed in References, Tech Memos published at NWFSC use the 
American Fisheries Society’s reference style. All authors should be made aware of the 
appropriate format. In addition, if you are planning to use EndNote or Zotero for 
references, make sure that all contributors are able to use it and are using the same style. 
It is not acceptable for, e.g., some references to be created with EndNote while others are 
typed in Word. In general, we recommend that one author assume responsibility for all 
references in a given project to ensure consistency.  
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NWFSC Scientific Publications 
Style Guide 

Format 
In contrast to previous versions of this Style Guide, there is no requirement to apply any 
formatting to the text of your document. You may type your manuscript using whatever font, line 
spacing, margins, etc., you feel comfortable with. However, figures—charts, maps, and other data 
visualizations—that do not follow the guidelines in Tables and Figures may be returned to 
authors for regeneration. 

All NWFSC Tech Memos and Processed Reports are published in a consistent format and layout. 
The overall appearance is determined in large part by the recommendations of the Government 
Printing Office and the NMFS Scientific Publications Office. Your document will be formatted to 
comply with these standards, and then layed out in InDesign. This means that the published 
document will look different from the manuscript you submit, even if you follow every 
recommendation on these pages. For this reason, we suggest that authors concentrate on the 
content, and leave the formatting to the Editor, who automatically checks all manuscripts for 
formatting issues as a matter of course. For authors who prefer to approximate the format of the 
final product while drafting, this section presents the standards used for scientific publications at 
NWFSC. 

Basic Mechanics 
Using styles 

Tech Memos use the fonts Minion Pro for text and Helvetica (Regular and Condensed) for titles 
and section headings. These are proprietary fonts and might not be installed on your computer. 
Don’t buy them (and definitely don’t download “free” versions from the Internet)—they will be 
applied during editing. You should feel free to type using whatever font you feel comfortable 
with. 

That said, applying Styles to your document will save the Editor some time. These can be found 
on the Home tab in Word. There are many predefined styles included there. Unfortunately, in 
preparing Tech Memos, we use some that do not come predefined. Word default styles include 
Title, Body Text, and Headings 1–5. (If they do not already appear in your Word toolbar, you can 
usually find them by clicking on the down arrow to the right of the box and selecting Apply Styles 
[on Mac, use the Styles Pane], then searching for or typing the name of the style.) 

We also use styles called Figure Caption and Table Heading to help generate lists of figures and 
tables, and Reference to easily format the list of references. These have been created in-house. 
Examples of each appear in the relevant sections of this Style Guide. 

There are many reasons for using styles, including: 
• They help to quickly and painlessly generate tables of contents and figures. 
• Modifications can be applied to the whole document at once. 
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• They are essential for creating the PDF file used when publishing the final version of the 
Tech Memo. 

Note: The default Heading styles in Word look different from those used in Tech Memos. This is 
unimportant. As long as you have applied styles to the different textual elements in your 
manuscript, they will be modified as needed during editing. Also note that Body Text is not the 
same as Normal, which is not used for formatting in Tech Memos. 

Layout 
Margins 
Use l-inch margins on all four sides of a standard Letter-size page. This setting is usually the 
default setting in Word (on the Layout tab, click Margins and select Normal). If the Normal 
settings are different in your version of Word, you can set Custom Margins at the bottom of the 
drop-down menu. 

Justification 
Do not Justify text flush right. Use Align Left (Ctrl-L or ⌘-L)	instead (it should be the default 
setting). This will give the paragraphs a “ragged-right” edge, as in this Style Guide. 

Line and sentence spacing 
You can set your line spacing to double in manuscripts submitted to the Tech Memo series if that 
is how you prefer to write, but the manuscript will be single-spaced when it is published. Put only 
one space after colons and between sentences.6 Body paragraphs are not indented, and should 
have one 12-point space separating them. On the Home tab, under Paragraph, select Line Spacing 
Options (or, on Mac, Line and Paragraph Spacing). Under Spacing, set After to 12 pt. More 
information about spacing appears in Spaces. 

Pagination 

Page numbers will be added to Tech Memos during layout, so they are not necessary in 
manuscripts. If you prefer to work with them (i.e., you will be printing a draft of your manuscript 
and are concerned that pages might get shuffled, etc.), we recommend centering them in a footer 
at the bottom of the page. That is where they will appear in the final layout. 

Page numbering will change between a draft and a layed-out proof. As such, it is best to refer the 
reader to sections rather than pages within a single Tech Memo (e.g., “This is discussed further 
under Histopathology”7 rather than “See page 12 for more details”). If you must refer to a specific 
page, write [000] instead of a number, as in “See page [000].” The correct page will be added 
during layout.8 

                                                
6 This is a change from previous versions of this Style Guide and reflects the use of proportional fonts in modern 
publishing; such fonts eliminate the need for two spaces between sentences, for both print and web typesetting. All 
fonts used in Tech Memos are proportional. 
7 Clickable cross-references can be added by the Editor to make navigating the PDF more convenient for your 
readers. Leave a Comment wherever you would like one inserted. 
8 Avoid the generic “see below.” It is unhelpful, as a reader will have no idea whether the related information is to be 
found further in the same section, in some other section any number of pages further on, or even in a figure or table. 
Be as specific as possible when referring to other sections of your manuscript. 
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Tables and Figures 
All tables and figures are numbered consecutively, provided with descriptive text, and mentioned 
at least once in the text. If a table or figure is not discussed, it should not be included. 

Table headings appear before the table; figure captions appear at the bottom of the figure. 
Descriptions should be ample enough to allow the table or figure to be intelligible on its own, 
without reference to the body of the Tech Memo. All unusual symbols should be defined in the 
description. For tables, citations and comments are footnoted with lowercase superscript letters.9 
For figures, citations and comments are treated within the caption. 

Remember that all images must be provided with alternative text for accessibility compliance. 
This is discussed in further detail under Legal Requirements, as is NWFSC copyright policy. 

Formatting tables 

Build all tables in a separate Word document.10 If you have tables that require landscape 
orientation (i.e., they are too wide for a vertical page and should be rotated 90°), the easiest way 
to do this is to include those in another separate document. Both drafting and layout will proceed 
much more quickly than if the tables are included in separate sections within the Tech Memo. 

If you insert a table built in another application as an image, you will have to supply alternative 
text for it, so we recommend creating tables in Word, instead. Tables from Excel can be inserted 
into a Word document with a simple Copy–Paste. They will appear as Word tables, not images.  

To create a table in Word, go to the Insert tab and select Table. After you place the cursor in a 
cell, two new Table Tools (Design and Layout) will appear in your list of tabs. These will help you 
create the table you want by merging and splitting cells, inserting or deleting rows and columns, 
and choosing text alignment. All tables should be created in this way. Never create tables using 
the Tab key, as this causes problems for accessibility. 

You will find a selection of Table Styles under the Design tab. Please do not apply them. NMFS-
NWFSC Technical Memorandums have a standard table style, but it is not one of the Word 
defaults. The Editor will apply the appropriate formatting to all of your tables during layout. 
Here is an example of a typical Tech Memo table: 
Table F-1. Steelhead fisheries reported harvest by county for 1895.a 

County 
Gear 

Gill net 
(catch kg) 

Seine net Total (kg) 
Count 

(@ 4.5 kg) 
Run (40% 
harvest) 

King 204,704 — 204,704 45,490 113,725 
Snohomish 264,372 — 264,372 58,749 146,873 
Skagit 093,268 — 93,268 20,726 51,815 
Whatcom 347,856 010,503 

Total: 
358,359 
920,703 

79,635 
204,600 

199,088 
511,500 

aData from Wilcox (1898). 

                                                
9 Don’t use the Insert Footnote function (on the References tab) for this purpose. That is only for footnotes in the 
main body of the document. Create table footnotes manually by superscripting letters (Ctrl-Shift-+ or ⌘-Shift-+). 
10 In your manuscript, simply write “<Table x>” on a separate line after the paragraph where the table is first 
mentioned. The Editor will insert the required table as close as possible to this point. 
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This formatting is sufficient for the majority of tables. If you feel that your table is complex 
enough that additional formatting elements (e.g., vertical lines or alternating shaded rows) are 
required, the Editor will work with you to achieve a solution. 

Formatting figures 

Word embeds full-sized picture files into its documents, so placing many illustrations into the 
body of a Tech Memo tends to slow down computer performance considerably. For this reason, 
we ask that you submit all figures as image files in a separate folder. Label them clearly (e.g., 
“Figure 5.jpg”). Do not paste them into the body of your manuscript. Instead, write the figure’s 
number, caption, and an alt-text description (if necessary) in angle brackets on a separate line 
after the paragraph of first mention. For example: 

…The chemical structure of PBDEs consists of two phenyl rings connected by an ether 
bond with from one to ten bromine or hydrogen atoms attached (Figure 2). PBDEs are 
structurally similar to PCBs and have similar physicochemical properties. 

<Figure 2. Chemical structure of PBDEs. The numbers assigned to the carbon atoms indicate the potential 
positions of the bromine atoms on the phenyl rings. Alt-text: “Chemical diagram showing two 
hexagonal rings joined by single bonds to a shared oxygen atom.”> 

In general, several PBDEs are lipophilic, persist in the environment, and accumulate in 
ocean sediments because of their high binding affinity to particles (de Wit 2002)…. 

During layout, the Editor will place the figure as close as possible to this point, label it with the 
caption, and tag it with the alternative text. Depending on their size, both figures and tables may 
be aligned with the top or bottom margin of the page where they are first referenced. Very small 
tables may be placed into a two-column format. Full-page or very wide figures or tables may be 
rotated 90°. 

We recommend using a sans-serif font (preferably Arial, Calibri, or Helvetica) in all figures. For 
legibility, the size of the font should be no less than 8 and no more than 11 points. 

Color 
The Tech Memo series is published online in PDF format, so you may use color if it adds clarity 
to your illustration. Generally speaking, charts shouldn’t use more than five colors at a time, both 
for simplicity and for compliance with accessibility requirements. We must be able to 
accommodate those who, regardless of reason, view charts in black and white. Many charts are 
generated in Excel, older versions of which often use a default color palette that looks like this: 
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The problem with these 
colors is that they do not 
convert well to grayscale, 
as can be seen here: 

 
 

 
The red and purple sections become nearly indistinguishable, as do the green and light blue 
sections. On a pie chart this might be acceptable, but not on a line graph. For this reason, the 
NWFSC Communications team has developed a set of color palettes that, when grayscaled, still 
retain high contrast. 

Here is a side-by-side comparison of the above figure using the approved color palettes: 

Polychrome Palette Grayscaled Monochrome Palette Grayscaled 

    
 
Maps 
Some maps use color gradients to display various data plots. If your map uses more than one 
gradient, check to be sure information isn’t lost or conflated after grayscaling. (A simple test is to 
print the map on a black-and-white printer.) In general, maps should use color sparingly, 
applying it only to the most important features. 

In addition to the data they are depicting, all maps should contain the following elements: 
• A directional compass/north arrow and degree labels. North does not have to point 

precisely to the top of the page, but should generally aim in that direction. Degrees 
latitude and longitude should be clearly labeled, either on a grid or with tic marks. On the 
left and right sides of the map, the label orientation should be set to vertical to save space. 

• A scale bar. This is preferable to a ratio, as interpreting a scale bar is more spatially 
intuitive. A bar will also resize itself should the reader enlarge or shrink the image. The 
bar should have no more than two divisions, using common (and rounded) values (e.g., 5, 
10, 50, 100, etc.). The units on the scale must be the same as those used in the surrounding 
information (i.e., the caption and body text). 

• A legend. Explain what different map features mean. This can only be omitted on 
extremely simple maps where every feature is labeled. 

• Labels. NMFS Scientific Publications Office’s Instructions for Authors require labels for 
bodies of water (in italics) and land masses (not italics). Provide a title for your map. 
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• Citations. Within the figure, cite the spatial and/or tabular data used to make the map 
(e.g., GIS layers, tables, aerial/satellite imagery, raster files, etc.). Remember to include 
these in the document’s list of references as well.  

• A date/place stamp. The author (organizational unit) and the map’s production date 
should be included within the body of the figure. Maps often become separated from 
their parent document, and this provides a traceable path. Preferred format: NOAA 
Fisheries – NWFSC, August 2016. 

If supplying maps created in ArcMap, 1) export them as Map Packages so that they remain 
editable, and 2) include the highest-resolution output images possible. 

Organization 
This section applies mainly to Technical Memorandums. The organization of a Processed Report 
depends in large part on its function. Both types of reports must contain, at minimum, an 
executive summary/abstract, an explanation of the purpose of the report, and a list of references. 

Major sections 
Front matter 
The front matter comprises, in order: the cover, the title pages, a table of contents, a list of 
figures, a list of tables, a dedication (optional), an executive summary, acknowledgments 
(optional), and a list of abbreviations or symbols (optional). Most of these are not your 
responsibility. The table of contents and the lists of tables and figures will be generated after 
editing by the Editor, as pagination often changes during layout. The cover and title page are also 
generated by the Editor, though you must provide the information necessary to do so.11 Of the 
remaining sections, only the executive summary is required. 

Body 
The body of a Tech Memo, like most scientific writing, typically begins with an introduction 
followed by materials and methods, results, and discussion sections, though the exact number 
and names of your sections depend on the nature of the report. This does not apply to Processed 
Reports, which can be not much more than collections of tables or other data compilations. 

Back matter 
The back matter begins with the references. You may also choose to provide a glossary or some 
appendices, though these are optional. These sections (including all appendices) should be 
included within the same Word document as the Tech Memo itself. 

Some authors choose to submit PDF files to be included as appendices. These can’t be embedded 
in the Word file. The files should be clearly labeled (e.g., “Appendix B-2.pdf”), and alternative 
text must be provided for all images in the PDFs. The Editor will tag the images during layout. 

Supplementary material 

Some scientific publications allow authors to provide links to related materials online. Many 
publications, including the NMFS Scientific Publications Office’s own Fishery Bulletin and 
                                                
11 If you will not be printing your report and would like to use a nonstandard cover (e.g., a color photograph, NOAA 
Fisheries branding, etc.), please notify the Editor at the time of submission. 
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Marine Fisheries Review, provide this option due to limitations of space. Space, however, is not 
an issue for Technical Memorandums. While most Tech Memos range from 50–200 pages, the 
longest have been close to 600 pages long. 

Moreover, because NWFSC reports are official government publications, they need to be 
archivable in a way that journal articles might not. This includes making all essential information 
available in a single location. In the past, all Tech Memos have been printed, meaning that there 
were always at least a few paper copies available in the Center library. As we transition away from 
print, there still needs to be a single PDF file that is the official, archival copy of the Tech Memo. 

That said, some material may be impractical for inclusion in a paper (e.g., video clips or certain 
data visualizations like Prezis, PowerPoint slides, etc.). Use such material sparingly. You must 
provide an explanation for why the material is necessary; the final decision about whether to 
include it rests with the NWFSC Communications team. 

Supplementary material must be assigned a DOI number before it can be included. If present, it 
is referred to following the guidelines for URLs, with a hyperlink pointing to the DOI address.  
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Style Conventions 
This section covers some of the most common issues associated with style as it relates to NMFS-
NWFSC Technical Memorandums and Processed Reports. They are presented alphabetically. If 
you have a question about a style issue that isn’t covered here, you can refer to the list of 
Suggested Resources, or contact the Editor. 

Abbreviations 
Abbreviations and acronyms eliminate the repeated use of long names throughout a report. A 
useful list of standard abbreviations is included in the GPO Style Manual. 

Here are some standards for abbreviation usage for NWFSC publications: 

• Abbreviations are usually spelled out or defined at first occurrence, for example: 
Northwest Fisheries Science Center (NWFSC). Because the executive summary, body, and 
each appendix of a Technical Memorandum are somewhat independent, begin this 
process anew in each of those parts of the document. 

• Consider abbreviations singular and add -s to form the plural, unless they are units of 
weights and measures or inherently plural. 

• Too many abbreviations clutter the text and make reading difficult. One way to avoid this 
is to alternate an abbreviation such as JBS (for juvenile bypass system) with a short phrase 
such as “the system.” If many abbreviations are necessary, consider adding a list of 
abbreviations or a glossary. 

• If the abbreviation for two organizations is the same, avoid using it. For example, if a 
Northwest Power Planning Committee and a Council, both represented as NWPPC, 
appear in the same manuscript, you can refer to them as “the planning committee” or 
“the committee” and “the planning council” or “the council.” 

• The common abbreviations e.g. and i.e. are sometimes misused. Remember that e.g. 
stands for exempli gratia, meaning “for example.” In contrast, i.e. stands for id est, or 
“that is.” The English equivalents are preferable in formal prose, but the abbreviations are 
used in parenthetical material. 

• There is no period after “et” in the abbreviation et al. 

• Do not begin a sentence with an abbreviation such as O. nerka; spell out Oncorhynchus. 

• Do not use periods after abbreviations of weights and measurements (e.g., lb not lb.). Do 
not add an “s” for plurals (e.g., pounds = lb not lbs). 

• Abbreviate fathom as fth. The abbreviation fm stands for femtometer. 

• Abbreviate United States when used as an adjective: the U.S. border. Spell it out when 
used as a noun. 



 15 

• Spell out state names in text, headings, and references. Use two-letter postal abbreviations 
in tables to save space. 

• For abbreviated compass points in addresses, use one- or two-letter abbreviations without 
dots (even though this differs from the GPO Style Manual): NW, SE, W, N, etc. 

• Spelling out time periods (second, minute, hour, day, week, month, year) is generally 
preferable to abbreviating them, except when space is at a premium in tables. 

• When citing a reference credited to an organization, use the organization’s acronym or 
initialism in the text citation: (EPA 2005). In the references section, list the abbreviation 
followed by the name of the organization spelled out in parentheses: EPA (Environmental 
Protection Agency). 2005. 

• Unless an abbreviation is commonly understood (e.g., DDT for dichlorodiphenyltrichloro-
ethane), do not use it in titles or headings. 

Acknowledgments 
This section, if you choose to include it, should be kept short and factual. It is generally assumed 
that acknowledgment in this section is due to assistance or advice above and beyond the call of 
duty (e.g., it would not be necessary to acknowledge the NWFSC Technical Editor for editing 
your manuscript). A good rule of thumb is no more than two sentences per person or 
administrative unit being acknowledged. Because the section is more informal than the rest of 
the paper, titles are not usually used. Agency names, however, should be written out in full. 

Affiliations 
Authors’ names and the insititutions they are affiliated with at the time of publication appear on 
the title page of the Technical Memorandum. The lead author’s name appears first, followed by 
coauthors in (roughly) decreasing order of contribution. Affiliations (institutional names and 
addresses) appear below this, beginning with the lead author’s affiliation. If any coauthors are 
affiliated with the same institution as the lead author, their names appear without numbers. All 
coauthors from different institutions have their names followed by superscripted numbers. For 
example: 

Michael M. Pollock, Joseph M. Wheaton,1 Nick Bouwes,2 Carol Volk,3 Nicholas Weber,2 
and Chris E. Jordan 

Note: The Editor will lay out this page using the information provided at the time of submission. 
Please verify that all names appear as intended before delivering the manuscript. For example: 
An author goes by “Jim Wilson” in his daily life, but prefers his name written as “R. James 
Wilson” in publications. If the name provided to the Editor is written as “Jim Wilson,” that is 
how it will appear on the title page. 

As detailed in NWFSC’s policy document on Fundamental Research Communications, the 
NMFS Science Board has established the form and content of affiliations based on the author’s 
employment status. The format has been slightly modified for Technical Memorandums. There 
are four options for scientists affiliated with NWFSC: 



 16 

1. Full-time NWFSC employees (FTE) 

Division 
Northwest Fisheries Science Center 
2725 Montlake Boulevard East 
Seattle, Washington 98112 

2. Full- or part-time contractors 

Contracting firm 
Under contract to the Northwest Fisheries Science Center 
2725 Montlake Boulevard East 
Seattle, Washington 98112 

3. Cooperative Institute or other grantee 

Home institution 
Cooperative Institute or other granting organization 
Award number 

4. Visiting scientists 

Home institution 
Visiting Scientist at the Northwest Fisheries Science Center 
2725 Montlake Boulevard East 
Seattle, Washington 98112 

Coauthors affiliated with other branches of NMFS or other external institutions (the West Coast 
Region, the University of Washington, the SeaDoc Society, the Washington Department of Fish 
and Wildlife, etc.) should use the address approved by that institution. 

Capitalization 
The GPO Style Manual is the primary authority on capitalization. Some recurring issues are 
discussed below. 

• The words Federal and State are capitalized when used as or in place of a proper name: 
the Federal Government; in Washington State; the State manages shellfish harvesting. 
When they are adjectives, they are lowercase: several federal and state agencies. 

• Although the GPO Style Manual capitalizes Continental Shelf, the term often appears 
together with continental slope. For consistency, both terms should be lowercase. 

• Capitalize East Coast and West Coast when referring to the coasts of the United States. 
This follows the style of guides other than the GPO Style Manual. However, the west coast 
of North America is lowercase. 

• In general, lowercase northern, northwest, south, etc., when they indicate compass 
direction or location, and capitalize these words when they are regional or geographical 
terms that are accepted as proper names: the Pacific Northwest and Southern California, 
but the western United States and the south fork of the Stillaguamish River.  
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• Capitalize a geographical term (lake, river, ocean, etc.) that forms part of a proper name: 
the Pacific Ocean, the Fraser River. A common noun that comes second and applies to 
more than one name is usually lowercased: the Skagit and Snohomish rivers. Do not 
capitalize a generic term that follows a capitalized one: the Columbia River basin. 
Variations of these principles can occur based on context and accepted usage (e.g., Pacific 
ocean perch). 

Citations 
In scientific publications, the term citations is usually reserved for the indicators in text, figures, 
and tables that point to the references, and the term references usually means the descriptors of 
works cited, as in the references list at the end of the document. 

Guidelines for citations: 

• Every citation must appear in the list of references, and every reference listed must be 
cited at least once in the Tech Memo. 

• Citations can take either of two forms: “Tsuchie (2014) examines the effects of PCBs on 
juvenile salmonids…” or “The effects of PCBs on juvenile salmonids have been examined 
(Tsuchie 2014)…” 

• A parenthetical sequence of citations is listed chronologically, beginning from the oldest, 
then alphabetically within years: (Jalaeian 2002, McCall and Lawley 2005, Slagoski et al. 
2005, Hunt 2011a, 2011b). 

• Avoid the use of Anonymous or Anon. When no author names are given, credit the 
organization that printed the document or published the electronic source. Abbreviate 
the citation, and provide an explication in parentheses in the list of references: (SSA-ARC 
2010, NMFS 2012). 

See also the section on References. 

Unpublished data and personal communications 

When data are referred to in the discussion that have not been published or formally peer-
reviewed, they do not appear in the list of references. Instead, they are cited in parentheses. There 
are three main possibilities: 

1. The source of the data is the sole author of the report, or all of the authors together. In this 
case, the citation is simply the word “author” or “authors,” followed by “unpublished data.” This 
is true for all mentions of this data source. For example: 

…preliminary results appear positive, but more research remains to be done (authors, 
unpublished data)… 

2. The source of the data is one of the several authors of the report: 
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First mention: (S. M. Graves, unpublished data) 
Subsequent mentions: (Graves, unpublished) 

3. The source of the data is not an author of the report. In this case, an affiliation must be 
included: 

First mention: (K. Dennison, University of Washington, unpublished data) 
Subsequent mentions: (Dennison, unpublished) 

The data may also come from external sources with different affiliations: 

First mention: (K. Dennison, University of Washington, and A. J. Collins, SeaDoc Society, 
unpublished data) 
Subsequent mentions: (Dennison and Collins, unpublished) 

Depending on the type of information provided to the author(s), it may be more appropriate to 
refer to it as a personal communication: 

First mention: (K. Dennison, University of Washington, personal communication) 
Subsequent mentions: (Dennison, personal communication) 

Common and Scientific Names 
Our authority for common and scientific names of fish species is the American Fisheries 
Society’s Common and Scientific Names of Fishes from the United States, Canada, and Mexico, 7th 
edition. For fishes elsewhere, use FishBase.12 For other animals, plants, fungi, microbes, etc., use 
the Integrated Taxonomic Information System.13 

N.B.: The plural form fishes is used when different species are being discussed. For example: 

On the first midwater tow, only 25 fish of an unidentified species were captured. On the 
second tow, 502 fishes of a variety of species were captured. 

Some guidelines: 

• Provide the scientific name (Latin binomial) of any species the first time it is specifically 
mentioned, then use only the common name thereafter. This applies to the executive 
summary, the body, and each appendix individually. Scientific names are italicized in 
parentheses following the common names: “coho salmon (Oncorhynchus kisutch).” 

• It is not necessary to provide scientific names when referring to species in general: “The 
charter fishing industry is highly dependent on salmon.” 

• Reference to a genus already mentioned can be abbreviated, unless it occurs at the 
beginning of a sentence or there is a possibility of confusion (e.g., two or more genera 
beginning with the same letter). 

                                                
12 http://www.fishbase.org 
13 http://www.itis.gov 
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• When a common name contains two or more elements (Chinook salmon, humpback 
whale), use both throughout the manuscript. 

• For an unspecified species, do not italicize “sp.:” Oncorhynchus sp. For plural unspecified 
species, use “spp.” 

• Names of divisions and subdivisions higher than genus are capitalized but not italicized: 
“Salmonidae.” English names, though sometimes derived from the scientific names, are 
lowercased (e.g., “copepod” from “Copepoda”). 

Countries 
Names of foreign countries are generally spelled out. Countries whose names are compounds 
should be spelled out the first time they appear in the executive summary, body, and each 
appendix. They can then be abbreviated when used as adjectives, with periods (no spaces) 
between the initials: U.S. (United States), U.K. (United Kingdom), P.R.O.C. (People’s Republic of 
China), etc. 

Dates and Time 
Use the format DD Month YYYY (14 August 2013, not August 14, 2013). However, the month is 
placed first in tables where dates are in numerals: 08/14/13. 

If referring to a range of dates, use an en dash: 14–18 August 2013, 29 May–3 June 2014, etc. 

Do not use an apostrophe when referring to decades: 1990s, not 1990’s. To indicate a range of 
years, use 2004–2009. For inconsecutive years, use 2004 and 2009. Centuries are spelled out and 
lowercased: the twenty-first century. 

Use the 24-hour clock: 14:30, not 2:30 p.m. Add a zero when the hour is between midnight and 
ten in the morning: 00:30, 04:45, etc. 

Equations 
When included in the body of the Tech Memo, equations typically function as clauses or 
sentences, and should be punctuated as required (e.g., with periods, commas, semicolons, etc.). 
Equations are centered, numbered in sequence, and designated by a numeral within parentheses 
set flush right, as below. 

 CH4 + 2O2 " CO2 + 2H2O (1) 

Cite the equation in the text as “Equation 1.” 

Put a space before and after mathematical symbols in equations, but no spaces before 
superscripts or subscripts. For relatively simple equations, the math symbols and the equation 
tools available in Word (on the Insert tab, select Equation) should be sufficient. For more 
complex equations, specialized software is advised. Remember, however, that if you insert an 
equation as an image, you must provide alternative text for it. 
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For additional guidelines, see Scientific Style and Format: The CSE Manual for Authors, Editors, 
and Publishers and The Chicago Manual of Style. 

Footnotes 
Footnotes are numbered sequentially throughout the text using superscript numbers. They 
should be used sparingly. In Tech Memos, the footnote number is placed after the punctuation 
mark, except in the case of an em dash or when the footnote applies only to material contained 
entirely within parentheses. In Word, on the References tab, choose Insert Footnote with your 
cursor in the appropriate location. 

Footnotes are required for providing URLs. 

Footnotes are not used in executive summaries. When using footnotes in tables, since numerals 
can be confused with exponents, use lowercase superscript letters (a). Manually place the 
footnotes below the body of the table (do not use the Insert Footnote command). For an example, 
see Formatting tables. 

Foreign Words 
Most Latin derivations, abbreviations, and phrases are no longer italicized. This includes the 
familiar i.e., e.g., cf., etc., and et al., as well as phrases like in situ, in utero, en route, and many 
others. When in doubt, consult Merriam-Webster’s Collegiate Dictionary, 11th edition. 

Check foreign words in a foreign language dictionary, or the original source when quoting. 
Include diacritical marks in foreign words (e.g., El Niño). If an author’s name contains diacritics 
that you cannot reproduce, indicate so in a Comment—the Editor will place them where needed. 

Latitude and Longitude 
Abbreviate latitude as lat and longitude as long. The abbreviation of each precedes its coordinate. 
When used together, latitude is given first: lat 20°N, long 120°W. Note that 20°N is written 
without spaces or a period following the direction. 

When specifying degrees, minutes, and seconds, use degree signs (°), primes (′), and double 
primes (″), not superscripted Os, apostrophes, and quotation marks. Compare: 

Correct: lat 20°15′09″N Incorrect: lat 20o15’09”N 

Latitude and longitude can also be expressed in decimal degrees if that coordinate system is 
consistently used throughout the document (e.g., lat 47.645°N, long 122.307°W). Be consistent in 
the number of decimal places used (i.e., do not use three in one section and five in another.) 

Lists 
Lists can be bulleted or numbered. When listing items in numbered sequence within a sentence, 
follow numbers with a single parenthesis. For example: 
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The habitat elements of this study were to 1) describe fish and habitat relationships, 
2) identify factors causing decline, and 3) identify actions for recovery. 

For longer lists, allow Word to create them for you. On the Home tab, choose Bullets or 
Numbering to quickly and easily create lists. Generally, it is understood that the items in a 
bulleted list should be more or less interchangeable, whereas those in a numbered list must (for 
whatever reason—importance, chronology, etc.) appear in a specific order. 

Numbers 
The rules for when to spell out numbers and when to write them using numerals are complex 
and often self-contradictory. Here are a few guidelines for some of the most common issues. 
When in doubt, consult the GPO Style Manual or contact the Editor. 

• Never begin a sentence with a numeral; spell the number out or rewrite the sentence. 

• Spell out cardinal numbers from one through ten, unless they are part of a unit of 
measurement or time (e.g., three species were identified but 8 kg, 3.5 hours, or 6 October 
2009). 

• Spell out ordinal numbers in text: first, second, third, …, tenth. Use the shortened forms 
after 11th and in tables and figures: 1st, 2nd, etc. Do not superscript the suffixes. 

• Spell out fractions, unless they are part of a unit of measurement: one-half of the fleet, but 
not a one-half m squid. In units of measurement, convert fractions to decimals or 
percentages: the net was 0.5 m in diameter; 25% of age-2 salmonids. 

• A zero always precedes the decimal point in values less than one. 

• Trailing zeroes can often be dropped: not 10.0°C or 0.350 g, but 10°C and 0.35 g. An 
exception would be when maintaining a certain number of decimal places for consistency 
among measurements (e.g., all entries in a table are calculated to four decimal places). 

• Numerical ranges are expressed with a single unit symbol after the second number of the 
range: 25–30%, not 25%–30%. In ranges of numbers, use an “en dash” (instead of a 
hyphen) with no spaces around it. To make an en dash, press Ctrl or ⌘ and the number 
pad minus (not the minus on the top row of the keyboard). More information on dashes 
can be found in Dashes and Hyphens. 

• Four-digit or larger numbers (except years) in text, figures, and tables always have 
commas every three digits (counting from the right): 1,000 (not 1000), except after the 
decimal point: 3.14159. Follow the GPO Style Manual in using the forms 1.6 million (not 
1,600,000) and 300,000 (not 300 thousand). 

Quotations 
Quoted text can be 1) enclosed in quotation marks within the surrounding text, or 2) set off as a 
block quotation. All quoted text must be cited/referenced. In general, a short quotation (no more 
than four lines) is enclosed, while longer quotations are set off as a block: 



22 

Block quotations start on a new line and are not enclosed in quotation marks. The block 
is indented 0.5 inch from the left and right margins. The citation of a block quotation can 
be placed in parentheses at the end of the block, inside the ending punctuation mark 
(Quimby, 2015). 

Omitted text is indicated with the use of an ellipsis: “Sediments or tissues… are customarily 
analyzed in batches of 12 to 14 field samples (Sloan et al. 2014).” 

Quotations within quotations are set off using single quotes. Square brackets may be used to alter 
verb tenses and capitalization to better fit the flow of your train of thought: “According to 
Salvucci and Taatgen (2012), ‘[D]rivers [are] increasingly engaging in secondary tasks while 
driving’” (Lewis, 2016). 

References 
Technical Memorandums and Processed Reports in the NMFS-NWFSC series use the reference 
style developed by the American Fisheries Society.14 The best source of examples and 
explanations of this stye is A Guide to AFS Publications Style, Chapter 8. This section of the 
NWFSC Style Guide summarizes some of the key points and provides an abridged set of 
examples. 

All contributors to a submitted manuscript should be familiar with the contents of this section. 
Alternatively—and preferably!—we recommend that one author assume responsibility for all 
references in a given project. This will help ensure consistency, especially in longer manuscripts. 

Entries in the references section are listed alphabetically in hanging indent format, with the first 
line flush left and subsequent lines indented 0.3 inch. Non-peer-reviewed (“gray”) literature (i.e., 
unpublished data or personal communications) is not included in this section, but is referred to 
in citations where appropriate, as described in Citations. 

Note: There can be more than one references section in a Tech Memo. Typically this happens 
when appendices contain their own citations of sources. In this case, it is more convenient for 
readers when each appendix contains its own (even very short) references section—even if many 
of the sources are the same. 

Reference managers 

Reference managers are programs that help authors keep track of references and citations within 
their reports. Popular examples are EndNote and Zotero. NWFSC owns an EndNote license, and 
the IT Helpdesk can install EndNote on your computer quickly and at no extra cost. Zotero is 
available as a plugin for most web browsers, and can be installed without assistance from IT. The 
Editor recommends using one of these programs, as a well-maintained reference manager not 
only saves an author time, but helps ensure consistency in the use of citations and references. 
However, if you choose to do this, please make sure that all contributors are a) using the same 
reference manager, and b) using the AFS reference style. 

14 This is a change from all previous versions of this Style Guide and took effect on 1 January 2017. 
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The AFS style is available by default in both EndNote and Zotero. In EndNote, under the Edit 
menu, hover over Output Styles and select Open Style Manager…. Scroll down to Trans Amer 
Fish Soc and click the checkbox, then click the Edit button at the bottom of the window. In the 
left panel of the window that appears, look for Bibliography. If the triangle is pointed to the right, 
click it to expand the submenu. Under Bibliography, click Author Lists. On the right of the 
window, under Abbreviated Author List, select List all author names. Repeat this process for 
Editor Lists, then close the window. You will be prompted to save your changes. Select Save, and 
name the style whatever you like. (The Editor recommends “AFS for NWFSC.”) Now, uncheck 
Trans Amer Fish Soc and scroll to AFS for NWFSC (or whatever you called your newly saved 
style). Make sure the box is checked and close the window. Finally, open the Edit menu, hover 
over Output Styles, and select the new style from the list that appears. 

In Zotero, the style is called American Fisheries Society. Simply make sure this is selected as the 
Citation Style when you add a citation or bibliography. 

For authors who prefer not to use a reference manager, the next pages in this section summarize 
some of the most important information about the AFS reference style. 

General rules 

• Place spaces (for non-breaking, use Ctrl-Shift-space on both PC and Mac) between initials 
in authors’ names, and add commas between names. Eliminate spaces between colons 
and page numbers. 

• Do not abbreviate the titles of journals, organizations, government departments, 
universities, etc. Spell them out in full. 

• Use the published capitalization for the titles of books, articles, chapters, etc. This may be 
Sentence case (capitalize only the first word of the title and any conventionally capitalized 
proper nouns), Title Case (capitalize all words except for articles [a, the], prepositions [in, 
at, with, during], and conjunctions [and, or, but]), or ALL CAPS (treat this as Title Case). 

• Avoid the use of Anonymous or Anon. When no author names are given, credit the 
organization that printed the document instead: (SSA-ARC 2010). Abbreviate the citation, 
and provide an explication in parentheses in the list of references: 

SSA-ARC (Social Security Administration—Accessibility Resource Center). 2010. Social 
Security Administration guide: Alternate text for images, ver. 1.2. Available: 
www.ssa.gov/ accessibility/files/SSA_Alternative_Text_Guide.pdf. (August 2016). 

Alphabetical order 

List references in alphabetical order by first author’s surname, then by additional authors’ 
surnames. References by a single author precede those with multiple authors. Alphabetical order 
takes precedence over publication date. 

List works by the same author(s) chronologically, oldest work first. If author order is exactly the 
same for several publications, list them in chronological order; if year of publication is also the 
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same, then list them alphabetically by title, and use a lowercase letter after the year (1997a, 1997b, 
etc.); the order of letters is determined by the alphabetical order of the sources, not by the order 
they are cited in text. 

Smith, J. M. 1997. 
Smith, J. M. 2001. 
Smith, J. M., and L. R. Adams. 1998a. Determinants of… 
Smith, J. M., and L. R. Adams. 1998b. Spawning Patterns in… 
Smith, J. M., L. R. Adams, and N. K. Peterson. 1998. 
Smith, J. M., and N. K. Peterson. 1997.  
Smith, J. M., N. K. Peterson, and L. R. Adams. 1996.  

 Examples 

This is just a sample of a few of the most common types of references. For more detailed 
examples, refer to A Guide to AFS Publications Style, Chapter 8. 

Book 
Zara, J. H. 1984. Biostatistician Analysis, 2nd edition. Prentice Hall, Englewood Cliffs, New Jersey. 

Chapter in a book 
Brett, J. R., and T. D. D. Groves. 1979. Physiological Energetics. Pages 279–352 in W. S. Hoar, D. J. 

Randall, and J. R. Brett, editors. Fish Physiology, volume 8. Academic Press, New York. 

Peer-reviewed journal article 
Rutherford, E. S., J. T. Tilmant, E. B. Thue, and T. W. Schmidt. 1989. Fishery harvest and population 

dynamics of gray snapper, Lutjanus griseus, in Florida Bay and adjacent waters. Bulletin of Marine 
Science 44(3):639–654. 

NOAA Technical Memorandum 
Myers, J. M., J. J. Hard, E. J. Connor, R. A. Hayman, R. G. Kope, G. Lucchetti, A. R. Marshall, G. R. Press, 

and B. E. Thompson. 2015. Identifying Historical Populations of Steelhead within the Puget Sound 
Distinct Population Segment. U.S. Department of Commerce, NOAA Technical Memorandum 
NMFS-NWFSC-128. DOI: 10.7289/V5/TM-NWFSC-128. 

Online sources 

If the literature you are citing is available online—whether exclusively, or in addition to a print 
version—add the online address at the end of the citation using the format below. If a DOI 
number is available, provide it. 

Anderson, J. J., E. Gurarie, C. Bracis, B. J. Burke, K. L. Laidre. 2013. Modeling climate change impacts on 
phenology and population dynamics of marine migrating species. Ecological Modelling 264(24):83–
97. Available: www.sciencedirect.com/science/article/pii/S030438001300166X. (September 2015). 
DOI: 10.1016/j.ecolmodel.2013.03.009 
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The DOI number should contain an embedded hyperlink to the address http://dx.doi.org/xxx, 
where xxx is the DOI number itself. The website URL is written without http:// at the beginning, 
though the hyperlink should contain it. Neither is underlined. This style differs from the 
treatment of URLs elsewhere in the text; see URLs, below. 

Unpublished data 

Personal communications, reports that have not been peer-reviewed, internal working papers, 
and other such collections of unpublished data may be used to inform the discussion, but do not 
appear in the list of references. They are cited at the appropriate point in the text. See Citations. 

Signs and Symbols 
Do not use English letters to approximate Greek letters (e.g., u for μ). These are very easy to miss 
during editing. Instead, on the Insert tab, choose Symbol, then More Symbols. (On a Mac, just 
choose Advanced Symbol.) Change the Font to Symbol and insert the appropriate letter. If you 
can’t find a particular symbol that you need, leave a Comment in the margin for the Editor. 

Some other quick points: 

• A space precedes and follows most operation or relation signs (e.g., =, ≈, ≠, +, –, ×, ÷, <, 
>, etc.) in mathematical expressions. 

• Spaces are not needed between signs and numbers when providing approximations, 
minimum/maximum ranges, confidence intervals, etc.: ~3 kg, >20 m wide, ±10%.  

• For multiplication, use a times sign (×), not the letter x. 

• Single letters for variables are in italics: n = 12; P < 0.01; c2 = 2.2727; r2 = 0.78. Note: n is 
for sample size only, not for number of samples or variables, etc. 

URLs 
URLs, or webpage addresses, are often long, unsightly, and even confusing. When pasted into a 
paragraph of text, a long URL not only creates formatting issues (e.g., white space at the ends of 
lines, or the need to add spaces where they don’t technically belong), but can also interrupt a 
reader’s train of thought as they scan past it looking for the continuation of the sentence. 

Consider this example: 

The sediment grain size data layer is available for download at the Pacific Coast Ocean 
Observing Station (PaCOOS; 
http://pacoos.coas.oregonstate.edu/archive/woc_sgh_grsz2.zip) and was derived from an 
interpolation of USGS usSEABED (Reid, 2006) and OSU (authors, unpublished data) 
sediment seabed sample databases. 

Instead, provide a hidden hyperlink (underlined) in the text, and put the full URL in a footnote 
(hyperlinked but unformatted). This is much less distracting to readers in all media. Readers of 
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an electronic document will be able to follow the link with a click or tap, while print readers can 
still refer to the footnote for the URL should they wish to copy it into a browser. 

Embed hyperlinks by selecting a word or phrase and pressing Ctrl-K or ⌘-K and entering the link 
into the Address box. 

Here is an edited version of the above example: 

The sediment grain size data layer is available for download at the Pacific Coast Ocean 
Observing Station’s (PaCOOS) West Coast Habitat Server,15 and was derived from an 
interpolation of USGS usSEABED (Reid, 2006) and OSU (authors, unpublished data) 
sediment seabed sample databases. 

Note that the format for URLs when providing links in the list of references differs from that 
outlined here. See Online sources for more information. 

Vessel Names 
Vessel names are given in full and are italicized. We use RV for research vessel, MV for motor 
vessel, and FV for fishing vessel (no slash, not italicized): RV Robert L. Emmett. If the vessel is 
part of NOAA’s fleet, it is referred to as “NOAA Ship” regardless of its designation: NOAA Ship 
Bell M. Shimada. Provide the vessel’s designation upon first mention within major sections of the 
report; subsequent mentions within each section can omit the designation for readability: 

…local vessels will not be able to effectively tow the sampling gear employed by the 
NOAA Ship Miller Freeman during slope surveys. The Miller Freeman is 215 feet (65.5 m) 
long… 

In alphabetical lists, vessels named after persons are alphabetized by last name, so RV George M. 
Bowers is listed under “B,” though the vessel name is not inverted (i.e., is not Bowers, George M.). 

Weights and Measures 
Use metric units for weights and measures of physical and chemical quantities. An exception is 
that crab catches are reported in pounds. Do not use periods after abbreviated units (e.g., lb not 
lb.) and note that there are no plural forms (e.g., 7 cm not 7 cms). Spell out names of units when 
used in text without an accompanying numeric value, though in figures and tables, unit symbols 
and abbreviations without accompanying numeric value may be used to save space.  

When used as an adjective, a numeral and its accompanying unit of measurement are connected 
with a hyphen: a 4-kg sablefish. 

If the actual measurement or specification is not already metric, provide an approximate metric 
equivalent in parentheses after the nonmetric measurement: a 17-ft (5.2-m) shark. 

Ratios involving two or more units of measure should be indicated by forward slashes: 
100 m2/km2, 45,000 ng/g, etc. Do not use negative exponents. 

                                                
15 http://pacoos.coas.oregonstate.edu/archive/woc_sgh_grsz2.zip 
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For Tech Memos, follow the capitalization rules found in the Chicago Manual of Style over those 
found in Merriam-Webster’s Collegiate Dictionary. When in doubt, check with the Editor. 

Some unit abbreviations are so common that they may be used without definition: 

°C degree Celsius G giga mg milligram 
cm centimeter h hour mL milliliter 
°F degree Fahrenheit Hz hertz mm millimeter 
k kilo L liter min minute 

kg kilogram m meter s second 
km kilometer M mega V volt 

g gram μ micro W watt 
 
Others should be defined upon their first mention, including: 

bp boiling point hp horsepower P probability 
Btu British thermal unit J joule pH measure of acidity 
cal calorie K kelvin ppm parts per million 
cg centigram kn knot  rkm river kilometer 
d deci n nano SD standard deviation 

fth fathom N newton SE standard error 
ha hectare nm nautical mile/ t metric ton 

  
nanometer 



 28 

Grammar and Punctuation 
The Editor will check grammar and punctuation in your Tech Memo during the editing process. 
The fewer mistakes there are, however, the faster the edit will proceed. This section describes 
some common issues to bear in mind while drafting your manuscript. 

If you have a question about a grammar or punctuation issue that isn’t covered here, you can 
refer to the list of Suggested Resources, or contact the Editor. 

Colons and Semicolons 
Always use a colon before a list and between a title and its subtitle. You can also use a colon to 
introduce a long quotation. Capitalize the first word after a colon only if the material that follows 
stands alone as a sentence or is the subtitle of a publication. 

Use a semicolon when the second of two clauses does not explain the first, or before a 
transitional expression (however, thus or therefore, nevertheless, etc.) that links them. Also use a 
semicolon to separate coordinate clauses (joined by and, or, or but) when they are long or when 
they contain commas. 

Do not use a semicolon to separate publications in parenthetical citations. Use only commas: 
(Jackson 2012, 2013, Smith et al. 2014). 

Comparisons 
When comparing two things in terms of their qualities, use the form X is bigger/more significant 
than Y. Do not use X is bigger/more significant compared to Y. If you want to use compared to, 
this is preferable: Compared to Y, X is bigger/more significant. 

When comparing things in terms of quantity, remember that more is allowed for all nouns, but 
less and fewer depend on whether the noun itself can be counted: 

There were more sharks than seals. (Sharks and seals are countable nouns.) 
We added more water to the tank. (Water is not countable and usually not pluralized.) 

There were fewer seals than sharks. (Fewer is used with countable nouns.) 
Tank A has less water than Tank B. (Less is used with uncountable nouns.) 

Contractions 
Scientific writing has a long tradition of avoiding contractions. Always write out the full forms of 
all verbs and negatives. The only acceptable use of an apostrophe is for possession. 

Dashes and Hyphens 
There are three types of dashes: the hyphen (-), the en dash (–), and the em dash (—). All three 
can be created with simple keystrokes. To create a hyphen, press either of the minus keys (top 
row or number pad). To create an en dash, press Ctrl or ⌘ and the number pad minus. For an em 
dash, press Ctrl-Alt-number pad minus or ⌘-option-number pad minus. Do not use two hyphens 
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(--) for an em dash. None of these dashes should ever have spaces around them. (In the 
mathematical expression 5 – 3 = 2, the “dash” is not a dash or hyphen, but a minus sign, and is 
surrounded by spaces. See Signs and Symbols.) 

En and em dashes 

Hyphens are discussed separately below. The en dash replaces “from… to” or “through” to 
indicate an inclusive range of values: 5–8 April 2015, etc. Uses for the em dash include: setting off 
an amplifying or explanatory element, showing a break in thought or a shift of tone—like this!—
or creating a strong break in the structure of a sentence. Em dashes can be particularly useful in a 
sentence that is long and complex or has a number of commas within it. They may also be used 
in table cells to indicate that data are missing. 

Hyphens 

Hyphenation is usually used to divide words at the end of a line, link certain compound words, 
or clarify two- and three-word modifiers. Because Tech Memo text is not justified, there is 
usually no need to hyphenate at the ends of lines. Hyphenation can be used sparingly in tables 
and figures. 

Many questions arise about when to hyphenate compounds. This relates to the phrase’s part of 
speech. A phrase used as a noun is not normally hyphenated: The charter boat sailed over the 
deep sea. When these same phrases are adjectival, hyphens are necessary: That charter-boat 
company offers spectacular deep-sea tours. That said, some adjectival phrases are traditionally left 
unhyphenated (e.g., sea surface temperature or whale watching tours). 

Some hyphenated phrases actually require en dashes instead of hyphens. This happens when the 
two words are joined, but do not modify each other. In the phrase a deep-sea tour, the first word 
in the compound modifies the second: the sea is deep. Use a hyphen here. However, in a phrase 
like the octanol–water partitioning coefficient, the first word in the compound is independent 
from the second: the water is not octanol. The same goes for the U.S.–Mexico border. In such 
phrases, use an en dash. 

The modern tendency is to eliminate the hyphen between prefixes and roots unless the root is a 
proper noun. For example, write nonnative, preadult, coauthor, and reexamine, but non-U.S. 
When combining prefixes with root words, hyphens help the reader distinguish when the 
combined form means something different than an already existing form (e.g., use re-cover when 
you mean “to cover again,” and recover for “get something back” or “get over an illness”). 

Some other common hyphen-related issues: 

• Do not hyphenate a two-word unit modifier when the first element is an adverb ending 
in -ly, as in naturally produced stock. 

• Sometimes it is necessary to use hyphenated combinations of letters and numbers (e.g., 
chemical congeners like PCB-52, or killer whales like L-112). When these appear in a list, 
they may break improperly across lines: the two antiestrogenic compounds PCB-138 and -  
180. During layout, this can be corrected using nonbreaking hyphens. 
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• Avoid hyphenating proper nouns unless they are unusually long and not breaking them 
would leave an inordinate space at the end of a line or when space is crucial (e.g., table 
column headings). If proper names must be broken, they should be divided syllabically; 
use a dictionary as your guide. 

• Terms such as 2–4 day old eggs are ambiguous. Do you mean an undetermined number of 
eggs that are two to four days old, or two to four eggs that are each just one day old? 
Following are examples of clear usage and the proper placement of hyphens. 

Eggs were 1 day old. 
We found 20 1-day-old eggs. 
Eggs were determined to be 11–14 days old. 
We found some 11- to 14-day-old eggs. 
We found 50–100 1-day-old eggs. 
Age-l walleye Pollock…. 
We used 100 m of line. 
We used l00-m line. 

Lay vs. Lie 
This is enough of an issue that a brief reminder seems warranted. When authors need to refer to 
the action of resting on the back, side, or belly, these verbs are often confused. There is a strict 
grammatical difference, however. Lay is transitive: it always takes an object. Think of it as a 
gentler synonym for put down or even drop: The mother is laying her child in the crib. Fish lay 
eggs. As a transitive verb, lay can be used in the passive voice: Over 12,000 eggs were laid in the 
nesting colony. 

Lie is intransitive: no object is required. It is often used with a preposition or prepositional 
phrase: The tired child is lying down. Dogs lie on their sides. Because lie is intransitive, it cannot be 
used in the passive voice. 

The conjugations of these verbs are easily confused. Here is a table of forms: 

 Present Past Present Past participle participle 
Lay lay(s) laying laid laid 
Lie lie(s) lying lay lain 

 
Note also that lay forms compounds such as lay out (e.g., graphic elements on a web page) and 
overlay. These compounds conjugate in the same way: were laid out, have been overlaid, etc. 

Parallel Constructions 
For effective and elegant writing, groups of equally important ideas should be presented using 
parallel constructions. Each element within a parallel construction matches the others in terms of 
both structure (words are paired with other words, phrases with phrases, and clauses with 
clauses) and grammatical function (nouns are paired with other nouns, adjectives with adjectives, 
and verbs with verbs). 
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Nonparallel constructions are most noticeable in a sequence of three or more items when one 
stands out as different from the others, resulting in an awkward and jarring delivery. 

Awkward: Orcas were taught to jump, splash visitors, pose on platforms, and fed a diet of 
frozen, dead fish. (Fed is not an infinitive verb like the others in the series.) 
Parallel: Orcas learned to jump, splash visitors, pose on platforms, and subsist on a diet of 
frozen, dead fish. 
 
Awkward: Samples were collected in the Straits of Juan de Fuca, Georgia and Puget Sound. 
(Puget Sound is not a strait.) 
Parallel: Samples were collected in Puget Sound and the Straits of Georgia and Juan de Fuca. 

Note that, when used properly, parallel constructions also allow some redundant words to be 
omitted (i.e., to in the first example, and in and the Straits of in the second). 

Certain pairs of terms always require parallel constructions, including: either–or, neither–nor, 
both–and, not only–but (also), and if–then. In these cases, be careful about the placement of the 
first term of the pair. For example: 

Concerns have been raised over the effects of exposure, both because of the worldwide 
use of fossil fuels, and the occurrence of oil spills. 

The phrase because of should be moved in front of the word both, as the occurrence of oil spills is 
also a cause of exposure. 

More details and examples can be found in the Chicago Manual of Style. 

Possessives 
To form the possessive of a singular noun or phrase, no matter what letter it ends with, add ’s: 
Amy’s report; James’s book; NMFS’s policy; the Northwest Fisheries Science Center’s library. 

To form the possessive of a plural noun or phrase, add ’s unless it already ends in s; then just add 
an apostrophe: the children’s toys; an authors’ checklist. 

Sentence Structure 
Sentence fragments should be avoided in scientific writing, except when saving space in tables 
and figures. Bulleted lists, procedural outlines, etc., contained in body text should be written in 
complete sentences. 

Complete sentences always contain, at the very least, one main verb. They also contain all 
necessary articles, prepositions, helping verbs, punctuation, etc. 

Fragmentary: 
b. Convert grid point layer to raster 
 i. If not already there add a Point_ID column to attribute table  
  1. Make as long integer 
  2. Field calculator Point_ID=FID+1 
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Complete: 
b. Convert the grid point layer to a raster image. 
 i. If it is not already there, add a Point_ID column to the attribute table: 
  1. Make it a long integer. 
  2. In the Field calculator, set the Point_ID to FID + 1. 

Spaces 
Your report will be typeset using proportional fonts. As such, there will be one space between 
sentences. If you have an unbreakable habit of typing with two spaces, feel free to continue this 
way. Simply run a global search-and-replace before submitting your manuscript. To do so, press 
Ctrl-H or ⌘-Shift-H. Next to Find what (or, on Mac, Search Document), type two spaces. Next to 
Replace with, type a single space. Then click Replace All. You may need to repeat this procedure 
more than once, until the number of replacements is zero. 

Scientific writing uses a large number of very small words, symbols, etc., many of which 
shouldn’t be broken at the ends of lines or pages. Initials (A. E. Smith), Latin expressions (et al.), 
short mathematical notations (P < 0.01), etc., should all be created using nonbreaking spaces. 
Simply use Ctrl-Shift-space (on both PC and Mac), and these expressions will wrap around lines 
and pages as if they are single words. 
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Legal Requirements 
NWFSC Technical Memorandums and Processed Reports are federal government publications 
governed by the NWFSC policy on Fundamental Research Communications. As such, they 
undergo a stringent review process with evaluations by internal (and possibly external) reviewers, 
the Division Director, the Technical Editor, and the Deputy Science Director. Some of these 
reviews are designed to help ensure that these reports comply with certain legal requirements, 
including those outlined in Section 508 of the Rehabilitation Act of 1973. This section describes 
some of the most common. 

If you have a question about a legal issue that isn’t covered here, please contact the Editor. 

Accessibility 
NOAA Technical Memorandums are the official publications of a government agency, so they 
must meet the requirements of Section 50816 of the federal Rehabilitation Act. To comply, all 
documents posted to the Internet (and to the Center’s Intranet) must be prepared in such a way 
that users with disabilities (e.g., blindness, inability to operate a computer with their hands, etc.) 
can access their content through assistive technology. For example, all figures—charts, graphs, 
diagrams, maps, etc.—must be accompanied by alternative text descriptions. Since Word has 
accessibility features that are convertible into PDF, Word is the preferred application for drafting 
Tech Memos. For NWFSC policy documents on accessibility, see Accessibility Tools.17 

Note: Many of the steps required to make a PDF accessible can only be performed once the 
document has been completely edited and layed out. As such, this is generally the last step of the 
production process prior to actual publication. It can be very time-consuming, especially if your 
report contains a lot of tables. (Tables are very difficult to format.) The Editor will give you a 
rough estimate of how long the process should take. 

Alternative Text 
The images included with Tech Memos (photographs, Excel charts, maps, equations and 
chemical structures drawn in external applications, etc.) must be tagged with alternative text 
descriptions. If a table is included as an image file, it must be tagged, as well. Alt-text is used by 
screen reading software to make the content of images accessible to people who cannot see it, as 
well as by voice input software to assist those who can’t use their hands. 

The most comprehensive advice about alt-text is in the Social Security Administration Guide.18 

Not every image requires alt-text. The SSA Guide identifies three main types of images: 
informative, redundant, and decorative. Informative images present important information not 
conveyed in the adjacent text. Alt-text is required for informative images. Redundant images 
contain information that is duplicated in the adjacent text or contained in the caption. Alt-text is 
usually avoided when redundant, as accessibility users shouldn’t have to listen to the same 

                                                
16 https://www.section508.gov/ 
17 https://inside.nwfsc.noaa.gov/computers/web/webpolicies/accessibility_tools.cfm 
18 https://www.ssa.gov/accessibility/files/SSA_Alternative_Text_Guide.pdf 
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information twice. Any information not conveyed in the surrounding text, however, must still be 
supplied in alt-text. Decorative images contain no information necessary for the comprehension 
of the document’s content, so alt-text should not be added to them. 

Providing alt-text 

We recommend including alt-text descriptions together with the figure captions within the body 
of your manuscript (see Formatting figures). Alternatively, you can type them up into a separate 
document—just be sure to clearly indicate which figure each description is meant to apply to. 
The Editor will tag the images with the alt-text during layout. 

Writing alt-text 

The SSA Guide presents very detailed explanations of how to write alt-text, including good and 
bad examples. Please refer to it for guidance. Here, we summarize the most important points. 

1. Always present the purpose of the image within the context of the surrounding information. 
In other words, do not merely describe the image; instead, explain its function in the Tech 
Memo. Why is it here? What information does it add that is not included in the 
surrounding text or the caption? 

2. Do not provide irrelevant details. If you are writing alt-text for a picture of a scientist 
holding a rockfish, the background of the picture may be unimportant. She could be 
holding the fish on a boat, in a lab, or anywhere else. Unless the location is helpful to 
understanding the purpose of the image, you don’t need to describe it. 

3. Do not repeat body text verbatim. The body text and caption will be read by assistive 
technology. If everything important about an image has already been mentioned in the 
caption and/or discussed in the body, you can simply say something like “This image is 
described in the caption,” or “Bar chart, as described in text.” 

4. If there is text in an image, repeat it verbatim. Text in images is “invisible” to a screen 
reader, so it must be quoted in alt-text. If the image is only text, simply copy it word-for-
word as alt-text. 

5. Combine separate images into one when they are visually and logically presented as such 
(e.g., a flow chart or hierarchy diagram). Even if the image is made up of separate files, 
write only a single description of the entire image. 

6. Supply the major trends and/or data points highlighted in charts, diagrams, etc. Do not 
repeat every data point individually; summarize only the most important information. 

7. Keep your description short and meaningful. There are no specific limits on text length, 
but the SSA Guide recommends keeping the description to approximately 160 characters. 
(This limit does not apply when copying image text as per recommendation 4.) 
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Copyright and Permission 
Works of federal government employees, when written as part of their official duties, are not 
subject to copyright. However, if a publisher takes that work and adds value to it (such as 
through editing or layout), that party can claim copyright on the new work. Thus, before we can 
reprint a NOAA employee’s work that was published in a journal, we may have to request 
permission from the journal. 

An alternative is to use the author’s original text, graphic, or table in the form in which it was 
submitted to the journal or publisher, because it has had no input or alterations. Still, in doing so, 
one should also indicate where else it has been published. Note that publishing agreements with 
authors usually grant the author/originator permission to reprint or adapt their own material 
from a copyrighted publication, but proper notice of copyright is typically required. 

Permission is not required to reproduce material from a Tech Memo elsewhere. Copyright law 
does not cover federal government publications; they fall within the public domain. Authors may 
reproduce any part of another federal government publication without permission, but citation 
of source is considered correct form. If you have questions or concerns about obtaining 
permission and crediting sources when reproducing work in a Tech Memo, contact the Editor. 

Disclaimers 
The following disclaimer appears on the inside title pages of NMFS-NWFSC Technical 
Memorandums and Processed Reports: 

Mention throughout this document of trade names or commercial companies is for 
identification purposes only and does not imply endorsement by the National Marine 
Fisheries Service, NOAA. 

This disclaimer suffices for the entire document, and does not need to be repeated every time a 
new trade name or company is mentioned. 

In addition to the above disclaimer, Processed Reports also contain the following disclaimer: 

The NMFS-NWFSC Processed Report series is for the dissemination of information only. 
Manuscripts in this series are not formally reviewed. All data herein are to be considered 
provisional. 

Other disclaimers 

In accordance with NWFSC’s policy on Fundamental Research Communications, a Center 
Division Director or the Deputy Science Director may require a disclaimer if your report 
contains statements that deal with issues of agency policy, management, or budget, and the 
statements could reasonably be construed as representing the view of the Department of 
Commerce or NOAA (when, in fact, they do not). In this case, the following disclaimer will 
appear: 
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The scientific results and conclusions, as well as any views or opinions expressed herein, 
are those of the author(s) and do not necessarily reflect the views of NOAA or the 
Department of Commerce. 

The policy also contains provisions under which authors may still publish a report even if it is 
not approved based on reviewer comments or judgments of the Division Director or the Science 
Director’s office. A set of procedures is outlined in the Fundamental Research Communications 
policy. If these procedures have been followed, the work is still disapproved, and the author(s) 
still want(s) to publish it, the following disclaimer will appear: 

This report was prepared by [Author(s)] in [his/her/their] personal capacity. The 
opinions expressed herein are those of the author(s) and do not reflect the views of 
NOAA, the Department of Commerce, or the United States government. 

Trademarks 
There is no legal requirement to use the symbols ® and ™ for trademark names. Omit them, and 
maintain capitalization conventions on all registered, trademarked, and brand-name items: 
Pyrex® is just Pyrex, and ImageTrak™ is just ImageTrak. 

When referring to a specific model of equipment in the document, provide the manufacturer’s 
name, city, and state in parentheses. For example: 

Amplified DNA was electrophoresed through an ABI Prism 3100 Genetic Analyzer 
(Applied Biosystems, Foster City, California). 
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